RED WING’

SOFTWARE

What's New in CenterPoint® Payroll Version 16

*Incremental version that is available on demand. Call Red Wing Software Technical Support to request this update.
Version 16.9

General Payroll

” Generic Retirement Export — Added the following optional available columns to the export — Base Hourly
Rate, Base Piece Rate, Base Salary Rate, Pay Period Abbreviation, Pay Period, Employment Status
Abbreviation, and Employment Status.

»? Fixes

»” Processes > ACH Notices > Create Prenote - Corrected an issue with creating ACH prenote files
for vendor payments.

Version 16.6/16.7/16.8

General Payroll

* Fixes

»? Processes > Purchases > Pay Invoices Due > Print button — Right-click Set as Default will now
load properly based on your Company/Bank Account/Sequence selections.

Version 16.4/16.5

General Payroll

” System
» Updated CenterPoint with the latest changes to US and Canadian zip/postal codes.
? Improved the design of the Notifications bar.
» Help
? Added a CenterPoint Training menu option to the Help menu.
»  About > Server Information tab - Improved the efficiency of the information displayed on the tab.
” File
» Preferences > Payroll
? General, Printing - Advices, Printing - Checks, and Time Sheets - The Current tab will
now display the currently used settings, even when no preferences are set.
» Printing - Checks and Printing-Advices - The default printing preference for Print SSN will
now be set to Last 4 Digits.

»? Preferences > General > Warnings - Added a new preference that allows you to suppress the
message that displays in Setup > Employees when a Tax State, SUTA State, or Workers'
Compensation Class has not been assigned to an employee when the employee is saved.

» Administration > Data Maintenance - Improved the layout of the screen and added functionality
with right-click options.
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” Setup
» Employees
» Copy - When copying a Template employee, all fields are now included except Abbreviation,
Last Name, Suffix, First Name, M.I., Social Security #, and Birth Date.
» Listtab

? Added optional Hire Date and Termination Date columns to the list of available
columns.

?  Added an optional Status column that allows you to filter the list by employment status.

» Add/Remove Columns - Added an optional available Job Tile column.

? Mass Update

» Added the following Federal Reporting Information fields to the General section of the
Mass Update Wizard: Agricultural Employee (Form 943), Employer Pays Employee
FICA, H-2A, Statuatory Employee (Form W-2), and Third Party Sick Pay (Form W-2).

»  Added the following fields to the General section of the Mass Update Wizard: SUTA
State, Tax State and Tax State (2nd).

? Added a Home Address option to the General section of the Mass Update Wizard
which allows you to quickly change the home address of multiple employees to an
alternate configured address (location type).

» Earnings - Inactive earnings at the Employer level will be excluded from the Earnings
list which makes it easier to update only active earnings.

» Added Use Alternate Flat Tax and Flat Tax Percent items to the Taxes section of the
Mass Update Wizard to allow updating the fields for multiple employees at once.

? Payroll Details

» Employers

?” Taxes tab - If the Workers' Compensation Overtime Earning Calculation method is
changed for a worker's compensation code already used in a pay run, an informational
message displays stating that changing the overtime calculation method may cause
classes to be reported incorrectly.

» New > Federal Taxes - Removed the obsolete Earned Income Credit tax selection.

»” Time Clock Settings > General tab > Synchronize - Improved the efficiency of the
synchronization process.

? Pay Defaults - Added new right-click Activate and Deactivate options.

» Deductions & Benefits - Added new Garnishment (Gross Wages) Employee Method which
can be used to allow for the calculation of garnishment as a percentage of the employee
gross. Renamed the existing Garnishment Employee Method to Garnishment (Disposable
Wages).

» COVID-19 Reporting Items - Added a Select Designation button to allow designating
COVID leave as either $511/day or $200/day limits. This will allow more accurate reporting of
COVID-19 Sick Leave on W-2s.

?  Accounts > Accounts

» ACH/Direct Deposit tab

? Increased the Processing and Cachet 3rd Party ACH Bank Account Numbers to the
NACHA maximum allowed 17 digits/characters (previously 15).

» Immediate Origin > Use Custom Number - Added the ability to enter alphanumeric
characters into the Custom field.

» Balances tab - Added comma separators to all numeric columns on the screen.
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?” Names > Names
» Expanded the width of email fields to accommodate 100 characters instead of 40 characters."

»? Addresses tab > Address for this Name List - Added a right-click Display Active
Addresses Only/Display All Addresses option that allows you to hide inactive/active
addresses.

? Combine - Names can no longer be combined when one of the names is an employee with
pay run history.

» Forms Designer > Check Form Designer - Added a new Detail/Check layout selection to the
Check Settings screen.
»? Processes
» Pay Employees

» Enter Pay tab - When entering pay, any state an employee has taxes configured for can now
be selected as the taxing or SUTA state, not just those with withholding configured (for
example, for states that do not have required withholding).

? Added an optional Local Tax column to the Enter Pay grid.

» ACH Files > Recreate ACH/Direct Deposit Files - Renamed the menu to Manage ACH Files and
added the ability to delete an ACH file so it can be recreated with different payments.
? Time Sheets

» Time Import > Time Clock - When a time card is imported that includes an earning subject
to a workshift with a workshift selected, the shift differential will now automatically be applied.

»? Time Entry - The Totals section will now be updated when entering Hours, Offered, or Pieces
from the Detail button.

? When using ALT + Left/Right arrow keyboard shortcuts to move between employees, focus of
the cursor will now return to the data entry grid when a new employee is selected.

» Filter tab - Added an optional Supervisor filter.

” Reports
» Payroll Reports

?” Added a new Last Pay Run date selection to Date filters to make it easier to run reports by last
pay run date.

» When a report is filtered by an employer, only the company names associated with the
employer will now display in the report title instead of all company names.

»? Payroll Tax Data Reports

» Workers' Compensation > Workers' Compensation, Workers' Compensation with
Employee Share, and Workers' Compensation (Detail) - Added an optional Job Title
column to the report.

» Tax Register - Added the ability to report separate Wages Over the Employee/Employer
columns to allow accurate reporting of wages over the limit for taxes that have different limits
for the employer and employee.

»? Payroll Data Reports

» Leave > Employee Leave Balances - Added an Is Leave Active filter to the report which
makes it easier to find current leave balances only for employees with active leave.

» Payroll Totals > Employee Time Sheet Hours Worked by Month and Employee
Earnings by Month and Payroll Tax Data Reports > Federal Tax Reports > W-2
Summary - Added a new Year report selection filter that contains a drop-down list of all the
years available in the database based on open periods.
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#* Deductions & Benefits > Retirement Plan Contributions - Added Hire Date and
Termination Date optional columns to the report.

» Payroll Setup Lists

»? Pay Defaults > Pay Defaults - Added a new Employee Pay Defaults report that includes pay
defaults that were assigned to your employees' Time Clock tab. This report is available only
when the CenterPoint Time Clock module is active.

»? Earnings > Earnings - Added an optional Expense Account column to the report.
» Employees
?  Employees
»  Added an optional Department report selection filter to the report.
?  Added optional Department and Supervisor report selection filters to the report.

» EEOC Employment - Changed the Payroll Activity filter label name to Pay Date which
makes it easier to understand how the report is being filtered.

? Employee Tax List - Added the following optional columns to the report: New 2020
W4 On File, W4 Step 2 - Multiple Job, Dependent Credit Amount, Other Income,
Deductions, and Non-resident Alien.

» Direct Deposit List - Added optional Social Security Number and Social Security
Number (Last 4 digits) columns to the report.

» Project Reports

? Project Summary - Added a new report that provides summary updates on project revenue,
expenses, and profit.

» Reporting Tools

” Transaction Search - When printing from Transaction Search, the columns will now print at the
same width they display on screen.

»? Fixes
” Setup
» Accounts > Accounts
»?  ACH/Direct Deposit tab > Advanced Settings - Removed the whtie space padding
in the Advanced Settings fields, which makes the modification of field data easier.
? When the Standard Entry Class on the ACH/Payments tab for a vendor is set to CTX,
the ACH file will now be formatted correctly.
» Employees
? Earnings tab - When a new expense account is created and used while editing an
employee, the employee can now be saved successfully without error.

”* Deductions & Benefits tab - Corrected the Limit Total Garnishments to [X] % of Net
Income calculation used to allow a limit for total garnishments to be set to a percentage
of the employee's net pay during the pay employees process.

* Processes

? Work Group Time Sheets - Time sheets can now be saved if an employee's local tax is a
valid local tax for the employee.

** Time Sheets

? In certain circumstances, names that are not marked as an Employee will no longer
display in time sheets.

» When historical time is imported, the start/stop time values will now be accurate.

? Fixed an issue with entering start/stop time when using AM/PM settings in
preferences.
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? Pay Employees
» When printing a check/advice that has overflowed, the overflow text will now be
displayed offset from the top of the stub the approximate distance of the stub header
when not overflowing.
» Enter Pay tab
? Detail button - In very specific circumstances when account distributions are
used/edited, the net pay amount posted will now match the printed check.
» Earnings can now be created and added to an open pay run successfully
without error.
?” General Journal Entries - Journal entries can now be successfully entered with two
asset/cash accounts.
» Purchases > Print/Email Checks - ACH payments that have not been included in a file will
no longer display in Print/Email Checks.
» Banking > Positive Pay Issue Files - Payments from the Pay Invoices Due or Payments
screens will now display in the Positive Pay file regardless of assigned transaction type.
” Reports
» Payroll Totals > Payroll Totals - Deductions will now always be sorted in alphabetical order.

? Payroll Setup Lists > Employees > Employee ACA Setup Detail - When multiple
employees with the same hire and termination dates display in order on the report, the dates
will now display for each employee.

? Payroll Data Reports

» Payroll Totals > Employee MTD, QTD & YTD Totals - Net Pay Totals will not be
increased by Third Party Sick Pay and Tips earnings when included in the report.

? Payroll Prepayment > Payroll Prepayment (Detail) - The report will now display
successfully when the Earnings, Deductions, Taxes and Earnings, Deductions, Taxes
Abbreviation columns are removed.

Tools

» CenterPoint Data Importer - When the Type of import is set to Employees, added Head of Household as a
Federal filing status choice.

Publish Pay Advices

? "Your Name' drop-down menu- Added a Help selection that displays documentation links available to the
service.

?  Added documentation links for Spanish-speaking employees. The documention can be accessed from the
Log In screen in Publish Pay Advices, from CenterPoint Payroll Help by selecting Menu > Add-On Modules
> CenterPoint Publish Pay Advices, or by clicking here

CenterPoint Employee Portal

» Added documentation links for Spanish-speaking employees. The documentation can be accessed from
the Log In screen in CenterPoint Employee Portal, from CenterPoint Payroll Help by selecting Menu > Add-
On Modules > CenterPoint Employee Portal or by clicking here.

» Fixes

»? Setup > Payroll Details > Employee Portal Settings > General tab > Synchronize - The
Employee Portal synchronization process was modified to match the middle initial length of two
characters in CenterPoint Payroll and will now complete successfully.
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https://resources.redwingsoftware.com/rwssnextfiles/kbdocs/general/centerpoint_employee_portal_for_employees_spa-MX.pdf

Version 16.3"

General Payroll

» Tax Reporting — Updated the second quarter 2021 Form 941 to reflect the recent changes made by the
IRS for reporting and calculating employer Social Security taxes for COVID qualified sick and family leave
wages

Version 16.2"

General Payroll

” Fixes

? CenterPoint Data Importer — The Accounts Type of Import and the first database in the Database
list can now be selected successfully.

Version 16.1
General Payroll

»? Fixes
” Setup > Payroll Details > Employee Portal Pending Changes - When database
security is set up, the Pending Changes report can now be printed successfully.

» Processes > Payroll > Direct Deposit > Create Direct Deposit Files- When Child Support
Addenda records are used in a direct deposit file, the Block Count will now be incremented and
display with the accurate count

» Reports > Reports > Payroll Data Reports > COVID-19 Reports - The Payroll Protection
Program Loan Forgiveness reports will now include Gross Tips in the Gross Wages total.

Version 16.0

General Payroll

» System

» The report favorites variations, report criteria, and reports export criteria and the CenterPoint
settings files will now be stored in the ...Documents\CenterPoint folder instead of in the Documents
root folder.

» Help - Reorganized the Help menu to make menus easier to locate. Added an F12 shortcut key to
the Remote Support Tool menu option.

? Tax Withholding - Updated Kentucky SUTA - Decreased wage base form 11, 100 to 10,800.

* File

? Payroll Administration > Taxes - The New Jersey Family Leave Insurance ( NJ FLI) tax rate will
now be maintained through CenterPoint Tax Table updates rather than manually entered under
Setup > Payroll Details > Employers > Taxes tab.

» Preferences > Interfaces > JobBOSS > Summarize - Added a new By Account (Except Employee
Checks) option that allows you to optionally post employee checks in detail while summarizing
employee advices and liabilities by account.
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” Setup

» Payroll Details

»

e

n

n»

»

e

Employers - Added a Family Medical Insurance Provided check box to the
ACA/Insurance Information section.

COVID Reporting Items > Retention Credit - Extended the retention credit
pay dates through 12/31/2021.

Time Clock Settings

» Synchronize - If an employee's supervisor is an inactive employee,
synchronization will now complete successfully.

? Added a Whitelist tab that allows exceptions to be made for certain IP
addresses if you are restricting clock in/clock out entries within the radius
of specific GPS locations, so they are not stopped by the
GPS restrictions. For example, for employees who clock in/out from
computers in your office rather than from a mobile device.

Local Taxes - Added an Annual Limit box that allows you to enter a maximum
yearly limit that applies to a Fixed Amount Tax calculation for local taxes.

Time Import Definitions > Definition tab - Added a Gross Receipts selection
that allows you to import gross receipts for Tip type earnings setup as Direct
Tips into Time Sheets.

Deductions & Benefits

?” Listtab - Added a new Add to Employees right-click option that allows
deductions and benefits to be added to selected employees.

When a new deduction/benefit is saved, you will now be prompted to
automatically add the new deduction/benefit to employees. Also added a
Add to Employees right-click option to the List tab that allows existing
deductions and beenfites to be added to employees.

» General tab - For deductions with the Percent of Gross Wages type,
added a Minimum Amount box to the Employee Detail section. When
processing payroll, if the calculated deduction amount is less than the
Minimum Amount value, the deduction amount will be set to the
Minimum Amount value.

»

» Employees

»

e

n»

n

Earnings tab - Added a Remove button that allows the removal of earning effective
dates (other than the default 1/1/2006 effective date).

Employment tab - The Reason box now saves previously entered termination
reasons in a drop-down list that can be selected from for future entries.

ACA Information tab - Added two additional available codes for an offer of an
Individual Coverage Health Reimbursement Arrangement (Employee & Spouse, No
Dependents) - 1T -with affordability determined by primary residence ZIP code and 1U
using primary employment ZIP code affordability safe harbor.

Deductions & Benefits

» When the Employer Method for a benefit is % of Gross Employee Deduction
(Multiple Rates) or % of Net Employee Deduction (Multiple Rates), added a Use
Capped Match Rate selection and a Cap Match rate at box that gives you the
ability to cap employer contribution percentages when calculating the employer
match. This allows benefits to be configured where the employer match limit is
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shared across multiple benefits.

»  Added a new Limit Total Garnishments to [X] % of Net Income field which will be
used to allow a limit for total garnishments to be set to a percentage of the
employee's net pay during the pay employees process.

»” Direct Deposit tab

?  Added child support addenda record information for Case/Court Order and
FIPS/Locator Code to the Direct Deposit Deduction Information section.

»? Processes

? Time Sheets

»  Added a Local Tax column to the Time Sheets grid.

? Time Imports > Time Import File - Imported time for Hourly earning types that don't include
an imported Rate will now calculate an Average Rate from the imported Amount and Hours.

» Pay Employees

” Void Checks - If there are published pay advices associated with employee check(s) or a
pay run being voided, a message now displays asking if the published advices should be
removed.

» Import Time Sheets - Added a simple overtime calculation that can be used if you have
hourly employees getting paid one hourly rate of pay. When time sheets are imported, the
hours over the overtime threshold are moved from the times heet to an Overtime Earning and
calculated at the overtime rate on the employee for the overtime earning.

» Time Import Files - Salary employee earnings are now prorated across imported hours.
Allows salaried employees hours to be imported from a time clock without affecting their
regular pay.

» Direct Deposit > Direct Deposit File Viewer - Added the ability to view Child Support Addenda
Records.

? Calculate Paid Leave > Calculate - When calculating Years of Service for the Once Yearly
calculation method, the calculated leave value will now be truncated to two decimal places instead of
rounding the value to eliminate any rounding error.

» Reprint Payroll Checks

»? Made it easier to get expected search results by changing the functionality of the Batch filter.
If a batch is selected, the Company, Bank Account, and Number From/To boxes will be
cleared, and the Date Selection will be set to All. Also, changed the location of the Change
Transaction Numbers check box.

? When a custom date selection filter is used to search for checks, the screen will now display
the checks for the specified dates.

» Reports
» Payroll Data Reports
’* COVID-19 Reports
? PPP Loan Forgiveness 8 Week and 24 Week Cover Period - Added taxable
retirement plan benefits to the Retirement Plan column.
» PPP Loan Forgiveness - Payroll Cost Details and PPP Loan Forgiveness -
Payroll Costs - The Employer Retirement Cost column will now include taxable and
non-taxable deduction/benefit types
» Payroll Prepayment > Tax Liability Prepayment - Added separate available Employee
Taxable Wages and Employer Taxable Wages columns.
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?” Time Sheets > Time Sheets
» Added an optional Earning Type and Earning Type Abbreviation column.
? Added a new optional Breaks column and report selection filter.
» Payroll Setup Lists > Employees

?* Employee Tax List - Added an optional Effective Date column and a Show Only Current
Elections report selection option that when set to No reports all effective dates which allows
the report to optionally include historical elections for past effective dates.

? Employee Earnings - Added an Earnings Is Active report selection filter that when set to Yes
allows you to include only active employee earnings.

Payroll Tax Data Reports > Tax Register - Added separate available Employee Taxable Wages
and Employer Taxable Wages columns.

Payroll Prepayment > Employee Prepayment (Detail) - Added an optional Hours Offered column.

»

n

»? Fixes

?” Reports > Export - When exporting a report to Microsoft® Excel that includes hidden groups, the
report will now include header text of the first visible group header and export successfully.
Processes > Payroll > Time Sheets > Detail > Accounting & Taxes tab > Local Taxes - In
specific circumstances, duplicate local taxes will no longer display.
” Setup

? Employers > Taxes tab - When a tax is set to Round Results, it will no longer inadvertently
modify the set up of another tax where rounding results do not apply.
Forms Designers - Added the missing toolbar option for Page Info that allows page numbers
to print on forms.
? Payroll Details

» Pay Defaults - If you use the same Expense account on multiple lines in the Expense

Account grid, the duplicates will no longer be consolidated.
»? General Journal Entries > Line Description - When entering a Line Description with

multiple words separated by the space bar, the Distribution box will no longer be
toggled.

»

»

Employee Portal Module

» The CenterPoint Employee Portal allows employees convenient online access to view and modify payroll
information.

» Payroll information, company announcements, or other information, can be added to the Home
section and edited at any time by the payroll administrator, making it easier for employees to stay up
to date on important company information.

? The CenterPoint Employee Portal consolidates all the Red Wing Software payroll web services into
one spot. Employees can open and launch CenterPoint Time Clock and CenterPoint Pay Advices
directly, making access to those services seamless.

? Employees can view and update their personal information (name, address, phone, and email),
Federal and State Withholding, and direct deposit allocation information from the Self-Serve section.
Before creating a new pay run or updating employee setup, the payroll administrator is notified of
any pending changes and can either approve or deny them. This makes payroll communication
between employees and payroll administrators very efficient.

? On the Quick Links section, payroll administrators can create useful links for employees to any
external web site or file. Use this section to communicate company policies or for providing benefit
information such as health and dental insurance, flexible spending, IRS, 401K, etc.
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Education Module

? Setup > Employees > Education tab - Added an Hours column that can be used to track the number of
hours an employee attended training/certification.

Tools

»” CenterPoint Data Browser - Added an Output Raw Data option that allows you to either export all data
associated with a report or limit the output to the columns/groups selected on the report in CenterPoint.
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